superhighways

harnessing technology for community benefit

o

Outlook tips

Organising your inbox & more

#DigitalFoundations



Digital Foundations programme

There are many ways we can help small community organisations make sound choices about the digital
tools and technology they use.
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Communications made easy Digital basics Websites for communities

Raise your profile using digital Work and collaborate online Put your website at the heart of
tools to engage supporters and using free and affordable digital your charity or community
fund your future tools and technology organisation’s story

Read more » Read more » Read more »

Find out more about the Digital Foundations programme


https://superhighways.org.uk/who-we-are/partners-and-programmes/digital-foundations
https://superhighways.org.uk/who-we-are/partners-and-programmes/digital-foundations

What we'll be covering today...

Settings & views

Flagging & categorising

Sorting, filtering & search

Sub boxes, moving emails & rules
Scheduling emails

Signatures & Out of office

Encrypting emails

* And becoming familiar with Settings options and using Help so you
can look things up & make changes in future * DG



Part 1 - Outlook web app (online Outlook via a browser)

Part 2 — Outlook local desktop app (e.g. Outlook 2016, 2019
or M365)



Microsoft 365 Training *«:! -

START WITH 6 SIMPLE STEPS >

X & & $ d® P & %

Outlook OneDrive Word Excel PowerPoint OneNote SharePoint Microsoft Teams Yammer

More Office apps —

Learn the basics Training templates Quick Starts Save time with tips
Get going quickly and easily with Microsoft 365 Learn what's possible with Word, Excel, and Get up to speed in no time with these popular Work smarter and get more out of your Office
video training. PowerPoint. guides. apps.

START NOW > DOWNLOAD NOW GET STARTED > GET TIPS >


https://support.microsoft.com/en-gb/training

Microsoft cheat sheets

v Outflook Mail on the Web Reai e tiilse TR N AVl

cheat sheet

Organize your Inbox

v Qutlook Mail for Windows

= utloo
CheOT SheeT = I Delete T Arcjve & Junk v & Sweep 53

> Favorites @ 2y Focuse d = Other @3 Filter ~ ..

O Grady Archie Al

> Inbox 46 To me

v Qutlook Calendar on the
Web cheat sheet

v'Qutlook Calendar for
Windows cheat sheet

Switch between Focused an

Other inbox.

Filter, sort, and turn on

Conversations and Focuse

Inbox.

d

d

> Social strategy me Cr—
_ Unread —I
Hi Megan! | have a ¢ See only your Unread messages.

m Microsoft



https://download.microsoft.com/download/F/6/6/F6690D5A-D61F-4F3D-B550-CD4A5882593F/MS_Cheatsheet_OutlookMailOnline.pdf
https://download.microsoft.com/download/F/6/6/F6690D5A-D61F-4F3D-B550-CD4A5882593F/MS_Cheatsheet_OutlookMailOnline.pdf
https://download.microsoft.com/download/E/B/B/EBB255D8-111A-4BFC-A5B0-88052DAA3B70/MS_Cheatsheet_OutlookMailforWindows.pdf
https://download.microsoft.com/download/E/B/B/EBB255D8-111A-4BFC-A5B0-88052DAA3B70/MS_Cheatsheet_OutlookMailforWindows.pdf
https://download.microsoft.com/download/F/F/0/FF0FE445-A384-4A50-A59A-A2D42656EBB7/MS_CheatSheet_OutlookCalendarOnline.pdf
https://download.microsoft.com/download/F/F/0/FF0FE445-A384-4A50-A59A-A2D42656EBB7/MS_CheatSheet_OutlookCalendarOnline.pdf
https://download.microsoft.com/download/F/1/8/F183FDC9-2863-4521-BFDB-D9B4247208F4/MS_CheatSheet_OutlookCalendarforWindows.pdf
https://download.microsoft.com/download/F/1/8/F183FDC9-2863-4521-BFDB-D9B4247208F4/MS_CheatSheet_OutlookCalendarforWindows.pdf

Part 1

Outlook web app (online Outlook
accessed via a browser)



Outlook Settings - -

“ Settings
Clle on the Cog Wheel C]t Kearch Outlook settings
the top right to access heme

Settings

Either scroll through or use

the Search box e.g. ‘Out of View al

Office” will find you the Pk s @)

Autqmoted responses o seed o O &

settings -
Desktop notifications () @ )

— ' . .. LN

View all Outlook settings &3



Changing your View

Select the View tab

Click on e.g. Message preview and Reading pane and
choose the options that suit you — e.g. whether you
have a preview of emails as well as a list

Choose to select (or not) Conversation View (this links
email replies in a single thread but allows you to
navigate to a specific email when you click the arrow
to expand the conversation)

Choose how your emails are sorted — e.g. by Date
(you can choose which order)

Alternatively use the View settings option (top right)
for more options including Focused inbox @)



Flagging emails for follow up

Useful as a reminder to

follow up on an email when (£, oo/ untes - |

d

you dont have time there Today

Ond theﬂ... Tomorrow
Right click on an email | This week
Select Flag Next week
Or select email and use | Nodate
the Flag/Unflag option in ¢ Mark complete
the menu bar, Home tab Clear flag
Here you can choose o T
timeframe

d®



Categorising email

Categorise your emails
against standard or
custom options — you can
then search and filter for
quick access

Right click on an emaill

S

Select Categorise & select © Svarai .

a Category

To add a new Category,
select New category

Pane”  Delete
Layout
Archive
) Focused filter Your Airtable woi
Move °
Free plan & -
@ > Your rec Copy S
Yesterday [Categorise >] L9 Search for a category
o Microsoft Mark as unread @ Green category
View your :
o Local Insight
Sign in to| Flag & Local Insig
k%1 61602° Pin Orange category
: Snooze > 4 Red category
Airtable
& \Website enquiry
You don't:
Block > Yellow category
This week
View > [ New category ]
The Airtab
e Scale your Advanced actions > Manage categories

©
%o



Choose Manage Categories
categories so you can:

Categorising your emails and calendar can help you organise and tra
or person. You can create new categories and assign them names an

Create a new category
Rename existing ones
Change the colours

+ Create category

@ Green category
@ Local Insight
< Orange category

& Red category

@ \Website enquiry

Y NN NN
B S E B & &

Yellow category

S
d®



Filtering & sorting

Filtering & sorting can help you
quickly find and action an email

Click on the Filter icon at the top
right of your list of emails

Either Sort on e.qg. Size, Date,
From (and reverse the sort to
suit) and your emails are re-
ordered accordingly

Or choose one of the Filter
options e.g. Flagged, Unread or
Has files — and only those email
will be shown

[ = Filter ] @ You forwarded this message on W
v 9 All
. irtable <noreply@airtable
&9 Unread
Sort by
K Flagged
99 v/ Date !
( B To me
q From
7’ Has files _
Size
@ Mentions me
! Importance
! Sort > _
Subject
Sort order )
e 16:00 Oldest on top

eam...
v Newest on to
Your Airtal P

d®



Using search

The Search bar is at the top of
your Window

By default, search will look in

all folders. Click the left arrow
to specify a particular folder

to search in e.g. Sent

Select the Filter icon at the
right of the Search bar for
Mmore advanced search
options as shown

All folders ~
y All folders
1 Inbox
; Drafts
e Sent ltems

Deleted Items

k)unk Email

é

J

Search

CcC

Subject

Keywords

Date from

Attachments

All folders

Select a date

[

=] to Select a date =




Sub folders

Setting up sub folders can help
you organise your inbox to find
emails you need..

Right click on your Inbox
Select Create new subfolder
Give your folder a name

Either right click on emails
and choose Move to folder

Or drag and drop emails to
this folder

o

-] Inbo

mboxlireate new subfolder ]
Ad

3 00 0 060 0 O

U LS

Bal Empty folder

Breé Mark all as read

Cal

De

Ma Assign policy

Permissions
Ma

Open in new tab
mTTI_I ~n

A6



Rules

Search for Rules via the
Settings cog and select
Inbox rules

Here youll see any rules
already applied to your
account

You can also Add a
new rule

Identify your new rule
with a name and then
choose the Condition

and Action from the
options available

Layout Rules

Compose and reply
You can create rules that tell Outlook how to handle incoming email messages. You chc

Attachments trigger a rule and the actions the rule will take. Rules will run in the order shown in the
at the top.

[ -+ Add new rule ]

Rules

Sweep

Junk email Q Otter

, If the message was received from 'no-reply@otter.ai', move the message to
Quick steps folder 'Otter.ai' and stop processing more rules on this message.

From
Rules
To
. My name is
1 ’ Otter invoices
I'm on the To line
o Add a condition I'm on the Cc line

‘ select a condition N ‘ I'm on the To or Cc line

I'm not on the To line

3 Add an action I'm the only recipient
‘ Select an action v ‘ Subject
Add an exception Subject includes

Subject or body includes
Stop processing more rules (D @
Keywords

Message body includes



Scheduling send
 Click the Down arrow

next to Send and o
select Schedule send

Schedule send

Set date and time

February 2021 N

*  Now choose the date S chedule sond y T T s
and time from | | Ol = =
suggested options or | Tomort morng il 5 16 17 8 19 20 2
Choose CUStom|Sed ‘ Sundaym-ornin-g Sun 08:00 ‘ 212 223 234 245 256 267 278
time and choose Ceme | oo

exactly when youd like _cnce | © 0800 .
the email to send e ] ‘
Cancel




Adding /[ editing signatures

Search for signature via the Settings
CcOg

Add your signature and choose
whether to include just in new
messages or also for replies and
forwards

Compose and reply

Email signature

Create a signature that will be automatically added to your email messages.

MY M AN B I U 2v Av

D Automatically include my signature on new messages that | compose

D Automatically include my signature on messages | forward or reply to



Out of Office (Automatic Replies)

Automatic replies

Search for Out of Office in

1 Use automatic replies to let others know you're on holiday or aren't
Settl ng S replies to start and end at a specific time. Otherwise, they'll continue
Then choose Automatic (LD rutomaicreteson ]

. D Send replies only during a time period
Replies

Toggle Automatic replies on

Set a date range (or a reminder
in your calendar to manually switch this

Send automatic replies inside your organisation

off when you'rre back!) S M A B I U £vAv= = =
YOU COn Set O different Add a message here
message to send internally
(tO your CO”eOgueS) Ciﬂd l Send replies outside your organisation ]
Send replies only to contacts

externally

%

d®



Open another mailbox via web

Click on your profile pic /
initials in the top right and
select Open another
Mailbox

Type in the maillbox you

need to open (thiS will Open another mailbox

Tab.

depend on what you have
access to) and click © suvermamas o
Open. It will open in a new
m‘ Cancel ‘



Encryption (via Outlook in the browser)

 With Business

Premium licences you | Show Cc

can also Encrypt
emails sent

Focu:

. Thank

. Create your email o
and click on Options Local |
Censu
« Then look for the 14 ne\

Padlock icon

Ellie H
> Cat

« Then click on Encrypt.
You can additionally
add on the Do Not
Forward option

Format text Options ‘

Show From Q v

Set permissions on this item

Vv

Confidential - All Employees

Do Not Forward

Encrypt

Highly Confidential - All Employees

No permission set



Part 2

Outlook local desktop app (standalone
e.g Outlook 2016 or 2019 or M365)



Changing your View

Select the View tab

Click on Change View and choose the option that
suits you — e.g. whether you have a preview of
emails as well as a list

Choose to select (or not) Conversation View (this
links email replies in a single thread but allows you
to navigate to a specific email when you click the
arrow to expand the conversation)

Choose how your emails are sorted — e.g. by Date
(you can choose which order)



Flagging emails for follow up

Useful as a reminder to
follow up on an email when
you dont have time there
and then..

Right click on an emaill
Select Follow up

Choose a time frame or
NO Date

You can then search on
Flagged emails

By Copy

&= Quick Print
(2 Reply

(|_—(_I Reply All

|_;_)I Forward

|;| Mark as Read

H Categorize

[> Follow Up

—

B Assign Policy

D Find Related
Quick Steps

=1 Rules

¥ Mowve

4 Move to Clutter
EL; Ignore

:-@ Junk

x Delete

» | > Today

’ | Tomorrow
’ | This Week
» | Next Week

3 |" No Date

3 |" Custom...

Add Reminder...

Mark Complete

Set Quick Click...

]

d®



Categorising emails

Categorise your emails
against standard or
custom themes — you can
then search and filter for
quick access

Right click on an emaill

Select Categorize & select
a Category

To add a new Category,
select All Categories

By Copy

é? Quick Print
2 Reply

r[;() Reply All
(3 Forward

@ Mark as Read

H. Categorize

[> Follow Up
& Assign Policy
[£] Find Related

Quick Steps
= Rules

X Mowve

l |
v Move to Clutter
E';Li{- Ignore

&.'S Junk

x Delete

EEE EEEEEEEER

(<% Mark Unread

==| Categorize ~ .

Birthday

Blue category
Consultancy
Datawise

Green category
Important

Must Attend

Non working day

Phone Call

Red category
Training

Orange category

Yellow category

[ i Al Categories...

d®



Choose New to add a
new Category

Or Rename existing ones
Or change the colours

You should then be able
to select these when you
next choose to categorise
an email

Color Categories X

To assign Color Categories to the currently selected items, use the checkboxes next to each category.
To edit a category, select the category name and use the commands to the right.

3
5

Shortcut key
[l sirthday
I Blue category

D Consultancy

. Datawise
I Green category

LT LTIz

D Important
DD Must Attend
I:‘. Non working day
DD Orange category

Phone Call
D Red category

[
[
|:| Traini ng
L]




Filtering & sorting

Filtering & sorting can help you
quickly find and action an
email

In the View tab, select
Arrange by

Now choose an option for
how you want to order your
emails

Select Reverse sort to suit

View Help Acrobat

e @/ = l | Reverse Sort ]

= Add Columns

Show Focused Message}|Arrange

Inbox Preview | Bvv [~ Expand/Collaps
N
Focused Inbox Date
d Other EQ From |
_ Eﬁ .

New messages (3)
Veston, Medium Daily Digest, Osce Sg Categories

Y F] Flag Status

soft F] Flag: Start Date
ur Microsoft 365 Business Standard

3 the Microsoft 365 admin centre to vie FU Flag: Due Date

[E size
e
able workspace has been switched to th El Su bject
You don't often get email from

FE Type
@J Attachments

rtable Team
ir automations by taking actions on mu

El Account

You don't often get email from | Importance



Using search

The Search bar is at the top of
your Window

By default, search will look in

‘ i File Home

<]

From Subject

All Mailboxes v

Current Folder

/" All Mailboxes

All Outlook Ite rﬂy

all Mailboxes. Click the drop
down arrow to specify a
particular Folder i

Click on the drop down arrow
at the bottom right of the
Search bar to see the
Advanced search options

- &
Search In All Mailboxes ~
Attachments v
Attachment Contains
Categories v
From
Body
Received Start Date ﬁ End Date ﬁ
Subject
To
+ Add more options



Sub folders

Setting up sub folders may
help you organise your inbox to
find emails you need..

Right click on your Inbox
Select New Folder
Give your folder a name

Either right click on emails
and choose Move to folder

Or drag and drop emails to
this folder

L_'E Open in New Window

New Folder...

Copy Folder

f|J;| Mark All as Read
%% Clean Up Folder
< Delete All

Show in Favorites

8| Sort Subfolders A to Z

* Move Down
Properties...
&n Convert "Inbox" to Adobe PDF
&n Append "Inbox" to Adobe PDE

d®



R u I es Y Move v FU Search People /
- v Address Book
= Rules e ! R
Always Move Messages From: noreply@airtable.com

I—OOk for RUleS In the Home Always Move Messages To: Superhighways Info
tab main menu bar

%g%zgegégi(?@;gé?ergove {?J;L Manage Rules & Alerts...
simple rule (e.g. move to a
oarticular sub folder) Create Rule X

Or select Create a Rule W gt it e s i
Ond bUild your Own DFrDm noreply@airtable.com

!tl[ % Create Rule... ]

|:| Subject contains | Your Airtable workspace has been switched to the new Free pl

using the options in the sentto [Superhighays i .
dialogue box

Se I eCt AdVG N Ced [_] Display in the New Item Alert window

Options for other rule Py aselectedsount: | Wndows Nery el o] [ | Browses
conditions and actions JMovethetem o folde:[Selec Folder e @)

oK Cancel [ Advanced Options... ]




Delaying delivery

In the Options tab in
the menu, click on
Delay Delivery

In Delivery options
choose the Date and
Time you want the
email to be delivered in
the Do not deliver
before box

Options Format Text Review Help Acrobat Q Tellme
ﬁ
=~ A 0> i i N7
:R V| % [ ] Request a Delivery Receipt
Bcc Encrypt | Use Voting _ Save Senf| Delay
v Buttons v [] Request a Read Receipt Item To | |Delivery
g
Delivery options
@ |:| Have replies sent to
[ Do not deliver before | 13/04/2023 ~  [17:00 v ]
|:| Expires after None v | |00:00 wv
Save copy of sent message



Adding [/ editing signatures

Untitled - Message (HTML)

e RE-aal Options Format Tex t Review  Acrobat ) Tell me what you want to do...

F\J b X E »” SmartArt

U Chart

Attach Outlook Busingss Calendar Signature Table Pigures Online Shapes hsho
File~  Item Card - - ensho

Signatures...

a Personal Statione
B 'S
:EI <] Select signature to edit Choose default signature 1
—r Cc... 1 E-mail account " katewhite@superhighways.org.uk ™ |
R New messages: (none) ~ i
: Replies/forwards: (none) o :
Save Rename, I

» Either choose an existing signature or click = [ w |
New | ——

Calibri (Body) ¥ M| B I U Automatic . Business Card
« You can then add this as your default
signature and choose whether it is added for
just New messages or in Replies & Forwards




Out of Office (Automatic Replies)

Click on File

Then choose Automatic
Replies

Select Send automatic
replies

Set a date range (or a reminder

in your calendar to manually switch this
off when you'rre back!)

You can set a different
message to send internally
(to your colleagues) and
externally

Automatic Replies - katewhite@superhighways.org.uk X

@ Do not send automatic replies

() Send automatic replies

Only send during this time range:
Tue 09/02/2021 23:00

Wed 10/02/2021 23:00

&% Inside My Organization & outside My Organization (Off)

Calibri 12

I'm off now till Mon Jan 4th - have a great break everyone - rest and
recharge :)

@Y

Rules...



Encryption

«  With Business Premium licences
you can also Encrypt emails sent

« Create your email and click on
Options

« Then look for the Encrypt &
padlock icon and click on the
down arrow

« Choose the Encryption and
Permission options

t Options Format Text Review Help Acroba

S— n O
ER El [ ] Request a Delivery Receipt

Bec Encrypt|] Use Voting

[ ] Request a Read Receipt

v Buttons ¥
SliET TR Set permission on this item £
katewhite @s Encrypt-Only

Do Not Forward
Confidential - All Employees

Highly Confidential - All Employees



Open another mailbox via local app

€
|f you hCIVG v Favorites All  Unread By Datev T
permiSSiOﬂ tO Sent ltems v Last Week
view and Deleted ltems 692 Alise from Infogram
h 2 LUrNnecLleEd Mnysworn 5y Free Dataviz Resources to Get you Inspired Thu 13/05

access O nOt er All the inspiration you'll need to get started. Get inspired right here on Infogram
Mmaillbox, it > Kylie Noble
should be listed Ol ot (1o o view i o wedsars Tl
. S Sue Quilter man-boy-a-positive-story-of-impact - Ready to View In er e
IN the |eft hO nd Q <https://d28bktdgjl0sby.cloudfront.net/email/assets/img/logo-otter@2x.png> Hi
pane > Superhighways Equipment v Two Weeks Ago
underneath

. : Alise from Infogram
your mGIn > Superhlghways HE|pdESk F Congrats Kate ! Sun 09/05
|n bOX Here's how to share your project with your audience. Congrats Kate! Your project

v Superhighways Info
CliCk On the » Inbox 24 ZDDm
name g nd the Drafts 4] \fl.clu've ex:ceeded your cloud recording storage r-ecurding limit o 08/05/2021
Hi Kate White, You have exceeded your cloud recording storage recording limit.

|ﬂbOX etC Sent ltems
should drop > Deleted Items 284 Alise from Infogram
down Archive 1 [ullKate Add Data and Create Powerful Stories 06/05/2021

Use interactive graphics to bring your data to life. Tell stories with interactivity and
hiHar



About Superhighways

Providing tech support to small local charities in London
for over 20 years

2]
=
Involvc(e:mentI ‘ S
onsultation Qutreach S
v Support Communications ~C°"ab°ra“°"Ph9rt:tf|ets -E Audio
. _ Capacity-Building Consultancy = Information
v Training Online-Fundraising Cutting-edge Social-media 2o
=~ Participation Digital-Storytelling|CTEffectiveness 2 &
v COﬂSU'tCI ncy " ICgmrlzluQthy-Engagement Support Digital-divide :’s;o
Lo . wdetesmeacshees] @CHNOIO
Digital inclusion Learning S 88 5. . PCs ALY
y - VideoS B2 RAsng ArencsS raing €8 o yoch
e Digital-by-default s :
Datawise London oo gTSDigita,_exc,gsign Laptopsg &3, Twitter
; E'E onnectivity = 3>
v See dll services Facchooks Wibatse | £O08 £ E5
- S =
v i T8
E-news sign up 3



https://superhighways.org.uk/training-advice-and-technical/training/
http://www.datawise.london/
https://superhighways.org.uk/training-advice-and-technical/
https://superhighways.org.uk/e-news/

Q@ superhighways

@ hamessing technology for community benefit

Thank you for listening

KATE WHITE

info@superhighways.org.uk
@SuperhighwaysUK

#DigitalFoundations


mailto:info@superhighways.org.uk
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